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and shows the major toolbars and menus.
That card can certainly help get you started.

They’re easy to find Most of the time, the
keystrokes required to initiate a command 
are very easy to locate within a program. Click
on one of the pull-down menu’s items at the
top of the screen, and you’ll see the action 
on the left and the shortcut keys on the right.
For example, when you click on the File menu
you will almost always see Open on the left
and <Ctrl>-O on the right. New is <Ctrl>-N.
(Mac users will find many keyboard shortcuts
are the same as the PC, but will have to sub-
stitute a different qualifier key, as the key-
board is slightly different.)

By holding down the Control key on the
keyboard and then hitting the appropriate 
letter, you can cause the command to happen
—without ever pulling down the menu. For
example, people are constantly telling you 
to “save, save, save.” When a file is open, click
<Ctrl>-S at any time and it saves the current
document with the current file name. If it’s 
a new, yet-unsaved file, you get a box asking
you to name the file. That’s just one example.
I’ll be more specific in a minute.

You may also see the Shortcut Keys in 
the status bar along the bottom of the screen
when you run your mouse over an icon on 
the toolbar. Watch for it! Often you have to 
dig around in the manual to find the nifty 
little shortcuts and timesavers. Some are not
that obvious.

More than one shortcut There is often two 
or more workable shortcuts to many common
commands. Pick the one you like or can asso-
ciate with the command. Across the list of
pull-down menus at the top of the screen in
any Windows-based program you will see the
standard menus, like File, Edit, View and 
Window, along with a few “program-specific”
menus. A drawing program might also have
Tools, Layout and Shape menus. A spread-

In the last issue, we looked at some of the 
uses of Cut, Copy and Paste features found 
in Windows and Windows-based pro-

grams. That article also described the Short-
cut commands, or Quick Keys, used to take
full advantage of the tools. There are hun-
dreds of shortcut commands—thousands 
if you count the ones offered by third-party
software developers. It’s impossible to
remember them all, but it pays to learn and
remember the ones that can save you a lot 
of time each week.

Don’t get me wrong—I sometimes use the
mouse for a common action or command.
But, when I am in “power designing mode,”
I take advantage of the speed of using the
shortcuts—especially in my familiar pro-
grams. Most programs include a Quick Refer-
ence Card that lists many of the shortcuts,

Save time with shortcuts 
and quick keys
They’re easy to learn and speed up common tasks

I

Mike Jackson

<Alt> plus an underscore menu letter
invokes the command. Here, Alt-E brings
down the Edit menu.

In any Windows program, the F1 key brings up the “program specific”
Help menu. In other words, if I’m in Gerber’s Omega program and press
the F1 key, Gerber’s Help program opens. In this case, I was in the Win-
dows Explorer utility and got the Windows Help menus.
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sheet program might have Table and Format
menus.

Notice that one letter, usually the first one,
is underscored. Hold down the Alt key, and
then press the underscored letter. That menu
will drop down. Once the menu drops down,
you see commands on the left with an under-
scored letter. When the menu is down, you
need only press that single letter to use the
command. The normal shortcut key for Copy
is <Ctrl>-C, but you can get the same com-
mand by Alt-E + C. For many of the secondary
tools used within your favorite programs, this
second method is the only way to get to the
shortcut key without the mouse.

These tips come in handy in Explorer or almost anywhere you run across a list of files in a folder or selection box.

Select All: <Ctrl>-A:This highlights the entire list.

Selecting a grouping of contiguous files from a list: Click on the first file you want from the list, then hold down the Shift key and click on the last file 
you want from the list. All files in between will be selected.

Selecting a grouping of non-contiguous files from a list: Click on the first file in the list, and then hold down the Control key while selecting any other files 
you want to select.

Selecting most of the files from a contiguous group: Use the combination of the previous two commands.You can select a grouping of contiguous files,
then hold down the Control key to “deselect” a few unwanted files from the selected group.

Inverting the Selection: Alt-E + I. If, for example, you want to select all but a few files in a big folder, select the ones you don’t want then use this shortcut 
command to unselect them and select all the rest.
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Working with lists of files

When trying to select multiple names in a list, first select the
top or bottom item you want from the list...

...then hold down the Shift key while selecting the top file-
name in the list. All the files between the first one and the
last one will be selected.

You can also select or unselect individual filenames from a
list by holding down the Control Key while making the selec-
tion. In this case, I unselected three files from the previous
list.

Basic Windows shortcut commands:
Open: <Ctrl>-O Opens a previously 

saved file.
New: <Ctrl>-N Creates a new file.
Save: <Ctrl>-S Saves the current file with

the current file name or prompts for a file-
name if none has already been assigned.

Print: <Ctrl>-P Brings up the print dialog
box where you can press Enter to start print-
ing the page.

Copy: <Ctrl>-C Copies the currently selected
item to the clipboard.

Cut: <Ctrl>-X Appears to delete the selec-
tion, but places it in the clipboard.

Paste: <Ctrl>-V Pastes the information
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stored on the clipboard into the document 
or box.

Help: F1 Brings up the Help menu for that
specific program.

Windows key: You won’t find this key on
older keyboards, but it’s a key with the Win-
dows logo on it. It pops up the Start menu.

Tab: Lets you move around within a win-
dow or form.

Some helpful, but not-so-apparent 
Windows shortcut commands:

Run: Press Windows key + R. Then enter the
application command such as “calc” (Calcula-
tor), “notepad” (Notepad), “cdplayer” (CD Play-
er) and so forth. Clicking on the Windows key
on newer keyboards brings up the Start menu
from the bottom left corner icon, then look
for the underscored letter. For example, Win-
dows Key + F + F will bring up the Find File 
or Folder dialog box.

Toggle Through Open Programs: Alt-Tab
This is a powerful command that will save
you from clicking on the taskbar. Say you
have CorelDraw, Calculator and Explorer all
open. You can jump between each with ease

When you press the “Windows” key, you get the large menu of 
commonly used applications and folders. Notice the underscored 
R in Run, indicating that you can press the R key to start the Run 
command.
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and speed with Alt-Tab.
Close Current Program: Alt-F4: Before shut-

ting down for the day, click this shortcut to
quickly close all open programs. Don’t worry—

you’ll be prompted to save
any changed or unsaved doc-
uments.

Close a “Not-Responding”
Program: Ctrl-Alt-Delete (hold
all three keys down at the
same time). Occasionally, a
single program will run into 
a bug and stop functioning.
Often you can use Ctrl-Alt-
Delete to let the computer
close the locked program
without affecting other cur-
rently loaded programs. It
brings up the “Close Program”
box where you can select any

currently loaded program or utility. Select the
problem program from the list and click on
the End Task button. You can also use this
command to turn off some of the unnecessary
little applications running in the background.

Msconfig: Windows Key + R, then type
“msconfig” (Windows 98). This little utility is
helpful when you want to turn off a few of the
little applications and utilities that get loaded
when Windows starts up each time. This

comes in handy when troubleshooting Win-
dows or when trying to open up some extra
RAM. I often turn off the unnecessary Task
Bar utilities when burning CDs. In the Mscon-
fig utility, simply click off the buttons on the
list. You’ll have to reboot for the changes to
take effect, but you can turn them back on at
any time.

Adding Programs to the Windows Start
Menu: Using either Explorer or My Computer,
locate the program’s executable file (usually
somewhere under the Program Files folder
and with an .exe suffix) and drag it onto the
Start icon in the lower left corner of the
screen. The program will now show up on 
the Start menu (when you click on the Start
button) each time you start the PC.

Run Windows Explorer: Either right mouse
click on the Start button and close Explore, or
hit the Windows key + R and type Explorer.

Internet Explorer shortcuts:
Refresh or Reload the page: F5.
Back one Page: Backspace
Send/Receive Mail: F5 or <Ctrl>-M (when in

your E-mail utility such as Outlook Express).
Print Specific Page of a site with frames:

Right mouse click in the area of the page you
want to print. This brings up a dialog box that
lets you click on the command to print the
page. When your printer dialog box appears,
check the box “only the selected frame.”

There’s more on www.signcraft.com

Click on Features to read:
■ Cut, Copy and Paste by Mike Jackson, May/June 2001
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When you press the Windows key, then the R key, this window opens.
You can type in the name of a program. In this case, typing in Calc will
open the calculator—something I use all the time.The filename you
used the last time always shows up in this window, so all I have to do to
run the calculator is to press the Windows key, then R, then the Enter
key.

Press the Windows key, then the R key.Then type in msconfig and hit
the Enter key. Msconfig lets you turn off some of the unnecessary mini-
apps that show up in the lower right corner of the screen when your
computer is rebooted, also you can turn them off manually after the
computer has been booted by holding down the Ctrl, Alt, and Delete
keys at the same time.

On a form, you can use the TAB key to 
jump around from box to box.This one
saves a lot of mouse clicks.
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After over 23 years of running his own commer-
cial shop, Mike Jackson and Darla, his wife, now
operate Golden Era Studios in Jackson,Wyoming,
and do a variety of sign-related projects. His Web
site is www.goldenstudios.com. His E-mail
address is golden@goldenstudios.com.

Save Specific Page from a site with frames:
Right mouse click in the area of the page you
want to save. When the dialog box appears,
click on the Properties of the page. This will
display the complete URL of the individual
frame page that you can highlight, copy
(<Ctrl>-C) and then paste (<Ctrl>-V) into 
the URL address box. From there, you can
save the page in your Favorites folder. This
comes in handy when you run across a site
with tons of unwanted flashing, blinking
advertising that might be held in one of the
other frames.

Select the URL address box: F4 highlights
the URL address on your browser and drops
down the list of recent URLs. You can scroll
down this with your arrow keys. (From here,
you could paste any URL address you had 
previously copied, to the clipboard.)

Find on This Screen: <Ctrl>-F is a nice 
feature that brings up a dialog box in which
you type in a word you are searching for on
that specific page. It will continue to search
down the whole page even though the word
might not actually be in view on the com-
puter screen.

Now that you know a few of these helpful
commands, be on the lookout for others that
you could use. Review the quick-reference
cards that come with most programs. Finally,
if you want to be a real power user, check out
a program called SmartPad [Softblox, 404-892-
0202, www.softblox.com].

If you missed it, check out Cut, Copy and
Paste on the Features section of www.sign
craft.com. •SC

MJack119.qxd  10/23/01  1:57 PM  Page 51


